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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(https://www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level
of the document.

For the most up-to-date information on development tools, see the MPLAB® X IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
dsPIC33A Curiosity Platform Development Board. Items discussed in this chapter
include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

» The Microchip Website

» Product Change Notification Service

* Customer Support

* Document Revision History

DOCUMENT LAYOUT

This user’s guide provides an overview of the dsPIC33A Curiosity Platform
Development Board. The document is organized as follows:

* Chapter 1. “Overview” — This chapter introduces the dsPIC33A Curiosity
Platform Development Board and provides a brief overview of its various features.

» Chapter 2. “Hardware” — This chapter describes how to program/debug the
board using the on-board programmer and the board’s main circuit elements.

* Appendix A. “Board Layout and Schematics” — This appendix provides
schematic diagrams for the dsPIC33A Curiosity Platform Development Board.

» Appendix B. “Bill of Materials (BOM)” — This appendix provides the component
list used in assembling the board.

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 5
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User's Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes Afield name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

Atab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, Risthe radixand nis a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mccl8\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants 0XFF, ‘A’

Italic Courier New

A variable argument

file.o, where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: {| }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]|1}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main
{
}

(void)

DS70005562A-page 6
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Preface

RECOMMENDED READING

This user’s guide describes how to use the dsPIC33A Curiosity Platform Development
Board. The device-specific data sheets contain current information on programming
the specific microcontroller or Digital Signal Controller (DSC) devices. The following
Microchip documents are recommended as supplemental reference resources:

MPLAB® XC-DSC C Compiler User’s Guide (DS50003589)

This comprehensive guide describes the usage, operation and features of Microchip’s
MPLAB XC-DSC C compiler for use with 16-bit devices.

MPLAB® X IDE User’s Guide (DS50002027)

This document describes the installation and implementation of the MPLAB X IDE
software.

THE MICROCHIP WEBSITE

Microchip provides online support via our website at https://www.microchip.com. This
website is used to make files and information easily available to customers. Some of
the available content includes:

» Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents, the
latest software releases and archived software

» General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups and a Microchip design partner
program member listing

» Business of Microchip — Product selector and ordering guides, the latest
Microchip press releases, a listing of seminars and events, listings of Microchip
sales offices, distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE

Microchip’s product change notification service helps keep customers current on
Microchip products. Subscribers will receive email notifications whenever there are
changes, updates, revisions or errata related to a specified product family or
development tool of interest.

To register, go to https://www.microchip.com/pcn and follow the registration
instructions.

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

+ Distributor or Representative

 Local Sales Office

» Embedded Solutions Engineer (ESE)
» Technical Support

Customers should contact their distributor, representative or ESE for support. Local
sales offices are also available to help customers.
Alisting of sales offices and locations is included in the back of this document.

Technical support is available through the website at:
https://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (June 2024)
This is the initial release of this document.

DS70005562A-page 8 © 2024 Microchip Technology Inc. and its subsidiaries
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dsPIC33A CURIOSITY PLATFORM
DEVELOPMENT BOARD USER’S
GUIDE

Chapter 1. Overview

INTRODUCTION

The dsPIC33A Curiosity Platform Development Board (EV74H48A) is a full-featured
development and demonstration platform enabling customers to explore the
capabilities of the dsPIC33A DSC family. Board operation requires the insertion of a
120-pin General Purpose Dual In-Line Module (DIM) containing a dsPIC33A DSC
device (purchased separately). The board supports custom feature expansion by
providing mikroBUS™ and Xplained Pro interfaces, allowing companion development
boards such as QTouch® extension boards, BIST-XPRO extension kits, various
sensors and interfaces via Click boards™ to be added. Information for supported
companion boards is available through the website at:
https://www.microchip.com/en-us/development-tool/EV74H48A.

The main hardware features of the board are highlighted in Figure 1-1.

FIGURE 1-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD

MCLR

DIM_VDD . ]*

Currel
Measurement *

ﬁ\ MICRoOCHIP

dsPIC33A 1
Curiosity Platform
Development Board -

EV74H48A Trace Header

FD Driver

ive Touch Pads
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e L a [ 5 e
T TR T2 T2R T3 T3R
sor s

1. dsPIC33A Curiosity DIM Connector
2. Integrated PICkit™ On-Board 4 (PKOB4) programmer/debugger

3. 2xmikroBUS™ interfaces for hardware expansion, compatible with a wide range
of existing Click boards™ from MikroElektronika (https://www.mikroe.com)

4. 1x Red/Green/Blue (RGB) LED
5. 3x general purpose push buttons
6. 8x general purpose green indicator LEDs

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 9
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MCLR Reset push button

10k Ohm potentiometer

9. 2 Xplained Pro Extension Headers

10. 100 mil male header for current measurements of DIM_VDD
11. 3 on-board capacitive touch pads

12. 6 100 mil headers for choosing redundant analog measurements of capacitive
touch pads

13. CAN/CAN-FD Driver circuit

14. 2 Channel USB Hub supporting PKOB4 programming and UART/COM channel
simultaneously

15. 1x3 pin 100 mil male header to select between 5V external or 5V USB power
16. 5V to 3.3V LDO

17. 50 mil RMII interface

18. 3.3V to adjustable 3.3V or 5V boost

19. 9-pin 100 mil trace header

20. 2x25 pin 100 mil female interface header for all DIM connections

21. USB-C® cable connector

22. 2Mbit SQI flash memory

7.
8.

1.2 POWERING THE BOARD

Choose between USB or external power via the 3-pin header J25 by shunting 2 pins
together.

1.2.1 USB Power

This board is intended to be primarily powered from the USB Micro-C® connector, J24.
The official “USB 2.0 Specification” restricts USB applications to consume no more
than 500 mA of USB VBUS power from the host. For applications higher than 500 mA,
5V should be used.

1.2.2 External Power

An external +5V VDC may optionally be connected through terminal connector J26.
Care should be taken to avoid exceeding a maximum of 6V on this input or damage to
the 3V3 LDO may occur.

1.2.3 Boost Circuit

In addition to the on-board 3.3V and 5V nodes, there is a power plane labeled in the
schematic as “Board_VDD.” Board_VDD utilizes the on-board boost converter to
power the dsPIC33A General Purpose DIMs and, depending on the DIM inserted, will
output either 3.3V or 5V. This is accomplished by connecting
“P55_Board_VDD_SELECT” to GND through a singular DIM pin. If a DIM is designed
with a 5V dsPIC33A device, the P55 Board_VDD_Select pin will be tied to GND and
the boost circuit will output 5V. Otherwise, P55 _Board VDD _Select is left floating and
the boost circuit will operate in Bypass mode, outputting 3.3V.

1.3 USING THE PROGRAMMED DEMO FIRMWARE

Each General Purpose DIM comes programmed with basic demo firmware which
exercises several of the board hardware features, based on available pin count and
modules for each device.

The source code for each demo can be obtained at:
https://www.microchip.com/en-us/development-tool

DS70005562A-page 10
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1.4

REPROGRAMMING AND DEBUGGING THE dsPIC33A DEVICE

The board has a PICkit™ On-Board (PKOB4) programmer/debugger circuit which can
be used to program and debug any dsPIC33A target device attached through the J1
DIM connector. Alternatively, an external programmer/debugger tool can be connected
to the board via the 6-pin in-line connector J11 using a male-male 100 mil pitch 6-pin
header or to the 6-pin in-line connector on the DIM itself. The PKOB4 circuit should
automatically enumerate and be recognized by the MPLAB X IDE, v6.15 or later, when
the dsPIC33A Curiosity Platform Development Board is connected to the host via the
USB Micro-C connector, J24. No custom USB driver installation is necessary as the
PKOB circuit relies on standard OS provided Human Interface Device (HID) drivers;
therefore, the driver installation should be fully automatic. When plugged in, the PKOB
programmer/debugger tool can be selected from the MPLAB X project properties page
by selecting the device under: Hardware Tools>Microchip Kits>Starter Kits
(PKOB)>Curiosity/Starter Kits (PKOB4), as shown in Figure 1-2.

FIGURE 1-2:

DSPIC33A CURIOSITY PKOB TOOL SELECTION

w Project Properties - 02_00960_test_firmware

B¢ Conf [default
- O PKoB4
Loading
v Libraries
» Building
XC-D5C
2 XC-DSC (Global Options)
i @ wcdscas

- ----- @ xc-dsc-gec
i @ xc-dscid
2 wo-dsc-ar

3 Analysis

Manage Configurations...

Manage Network Tools. ..

Categories; Configuration
oo @ General Family:
ies @ File Indusion/Exdusion All Families o

Connected Hardware Tool:

| Curiosity/Starter Kits (PKOB4)-SM:PLADD000000S | [[] Show All

Device:

dsPIC334K128MC106 w

Supported Debug Header:

MNone

[=l+| | dsPIC33AK-MC_DEV_DFP

-l 0.1.23

Compiler Toolchain:

[#-%C16 [Dowrload Latest
=-XCDSC [Download Latest]
B C-0SC (w3, 10) [C:\Program FilesWicrochip\wc-dsciv 3. 10bin]

L ¥C-DSC (v3.00) [C:\Program Files\Microchipixc-dscly 3.00'bin]

+--¥C-DSC (v3.10) [C:'Program Files\Microchipwec-dsclv3. 10.82'bin]

Cancel

Apply Linled: Help

© 2024 Microchip Technology Inc. and its subsidiaries
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Chapter 2. Hardware

21 USING THE USB-UART INTERFACE

Two USB-UART channels are available for communication from the dsPIC® device to
a PC via the USB connector. The MCP2221A provides the first channel, and the
PKOBA4 provides the second. Each channel will enumerate separately and can be used
simultaneously.

211 MCP2221A based USB-UART Channel

The board is equipped with a USB-UART interface based around the MCP2221A chip.
The MCP2221A chip implements the standard Communication Device Class (CDC) —
Abstract Control Model (ACM) protocol and, therefore, can use standard USB drivers
that are provided with modern Windows®, Mac® and Linux® operating systems. Under
most operating systems, the USB driver installation will be fully automatic. Under
certain older operating systems, or if the device is attached to a machine running an
operating system older than Windows 10 without an active Internet connection, manual
installation of the drivers may be necessary. In this case, the driver package can be
downloaded from:

https://www.microchip.com/mcp2221a

Details on how to access the serial port from Mac and Linux operating systems can also
be found in the associated collateral for the MCP2221A. Under Windows, after a
successful USB driver installation, the device will appear as a “COMx” port object in
which standard serial terminal programs can open/read/write to and from.

21.2 PKOB4 based USB-UART Channel

Since this board has a 2-port USB hub, it can support more than one COM channel at
a time. The second COM channel is connected through the PKOB4 directly to the USB
connector allowing two unique UART interfaces to be utilized from the dsPIC.

To utilize this interface, configure a UART connection to nets P102_UART_PKOB_TX
and P100_UART_PKOB_RX. All nets are named assuming the perspective of the
dsPIC device, and the respective device infosheet should be used to determine which
pins are designated to the USB-UART channel.

2.2 USING THE I12C BUS

Several on-board functions, including mikroBus A, mikroBus B, XPRO1 and 12C to
USB, support 12C capability. By default, these functions are tied together on the same
12C bus through 0 Ohm resistors R38 and R39, as shown in Figure 2-1.

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 13
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2.3

2.4

FIGURE 2-1: I12C BUS CONNECT
12C Bus Connect
R38
| P6 mkB B XPROI SCL,%EAAq&i% P67 mkB A USB SCL |
R39
| P4 mkB B XPRO1 SDA 'O_R/Wn\éﬁ‘ P65 mkB A USB SDA |

2.21 12C Bus Connect - Populated

While connecting all features on a single bus may provide a more streamlined 12C
experience, this also ties DIM pins P6 to P67 and P4 to P65 which limits the number of
general purpose header pins that can be utilized at a time.

In this configuration, the pins for the unused I2C module should be configured as digital
inputs.

222 12C Bus Connect - Not Populated

Removing R38 and R39 separates P6 and P67 as well as P4 and P65 into individu-
ally-controlled pins.

This groups the features supporting 12C into two separate 12C buses. mikroBus A and
12C to USB are supported on one bus, and mikroBus B and XPRO1 are supported on
the other. If all I2C-supported features are required, two separate 12C modules will
need to be configured in the dsPIC device.

RGB LED

Every General Purpose DIM is designed to support a PWM driving signal for each
individual color. This design allows a wide range of color options on the RGB LED.

FIGURE 2-2: RGB LED

RGB LED

GENERAL PURPOSE PUSH BUTTONS

The general purpose push button switches each have a pull up to Board_VDD. The
dsPIC 10 pins should be configured as digital inputs to utilize these switches. Keep in
mind that the switch is an active-low circuit.

DS70005562A-page 14
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FIGURE 2-3: GENERAL PURPOSE PUSH BUTTONS

R5
R2@' R3W:D RAMD ~@°P

0N
L.
S1

2.5 GENERAL PURPOSE GREEN INDICATOR LEDS

While the rest of the board has reference designators ordered from left to right, the
general purpose LEDs are ordered from right to left to signify an MSB to LSB
representation. This allows an easy display of up to 1 byte of data.

FIGURE 2-4: GENERAL PURPOSE GREEN INDICATOR LEDS

General Purpose LEDs

..oo .-t- ..m
IIC‘ -II .I‘I

LED7 LED6 LED5 LED4 LED3 LED2 LED1 LEDO

26 10K OHM POTENTIOMETER

The 10k Ohm potentiometer presents a simple method of providing an analog input to
the 12-bit ADC on the dsPIC33A devices. A 20 Ohm resistor is placed between the
potentiometer and Board_VDD, and another is placed between the potentiometer and
VSS. This limits the voltage range that can be input to the ADC from just over VSS to
just under Board_VDD, providing a method for detecting open and short circuit faults
on the input voltage.

FIGURE 2-5: POTENTIOMETER

@ETPCs
R13 R1a R16
a:5 0.0 p.p

Potentiometer

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 15
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2.7 XPLAINED PRO EXTENSION HEADERS

The XPLAINED PRO Extension Headers allow the use of both BIST-XPRO extension
kits and QTouch extension boards. Below is a table showing the functions supported
on each pin.

Note: Not all dsPIC33A General Purpose DIMs will support full functionality.
TABLE 2-1: XPLAINED PRO EXTENSION HEADER SUPPORT

EXT1 DIM Pin # | Pin Requirements | EXT2 DIM Pin # Pin Requirements
1 15 PPS / GPIO 1 NC NC
2 GND GND 2 GND GND
3 13 Analog / PPS / GPIO 3 20 Analog
4 11 Analog / PPS / GPIO 4 22 Analog
5 9 Analog / PPS / GPIO 5 24 Analog
6 7 Analog / PPS / GPIO 6 26 Analog
7 5 Analog / PPS / GPIO 7 NC NC
8 3 Analog / PPS / GPIO 8 NC NC
9 1 Analog / PPS / GPIO 9 NC NC
10 2 Analog / PPS / GPIO 10 NC NC
11 4 12C / PPS / GPIO 11 NC NC
12 6 12C / PPS / GPIO 12 NC NC
13 8 NC 13 NC NC
14 10 NC 14 NC NC
15 15 Analog / PPS / GPIO 15 NC NC
16 14 Analog / PPS / GPIO 16 NC NC
17 16 Analog / PPS / GPIO 17 NC NC
18 18 Analog / PPS / GPIO 18 NC NC
19 GND GND 19 NC GND
20 Board_VDD Board_VDD 20 Board_VDD Board_VDD

DS70005562A-page 16 © 2024 Microchip Technology Inc. and its subsidiaries



FIGURE 2-6: XPLAINED PRO HEADERS

Xplained Pro

Extensions

2.8 CAPACITIVE TOUCH PADS

The out-of-box jumper configuration allows each capacitive touch pad to be read

redundantly from two analog channels (Figure 2-7). For functionality purposes, only
one jumper from each pair is necessary to measure the touch pad.

FIGURE 2-7: CAPACITIVE TOUCH PADS
Capacitive Touch Pads

Guard J4 J5 J6 J7
Ring - . - -
g [o]gS

T1 TIR T2 T2R

@b Rr7 ®:0 Rs

:BGN

R124
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2.9 CAN/CAN-FD DRIVER CIRCUIT

The CAN/CAN-FD driver circuit utilizes Microchip’s ATA6563 CAN interface to
communicate through a 4-pin terminal header (J21). Installing shunts on J22 and J23
connects a standard 120 Ohm termination between CANH and CANL.

FIGURE 2-8: CAN/CAN-FD DRIVER CIRCUIT

CAN FD Driver

CANL Termination o
D2 J22 = M
CANL®- & [ =

iy C21
|
‘ P9

GND 2 = o @ canrxo

ERC20
e - TP8
GND & » [ B'¥ _ @ canxo

CANHwm- _ | _R42
D1 JJ23

CANH Termination

210 RMII INTERFACE

The RMII Interface allows the addition of the LAN8670-RMII Evaluation Board for
ethernet communication and other evaluation boards of a similar type if the feature is
available on the inserted DIM.

FIGURE 2-9: RMII INTERFACE

TXEN/P105 NC
TXDO/P107 NC
TXD1/P109  P8SY/NRST
P91/IRQ

P93/MDIO

PO5/MDC
PO7/CRS DV

RMHCEK IN/P11 1 P99/RXER
GND P101/RXD0O
ﬁ\(/;B P103/RXD1

NC
NC NC

211 TRACE HEADER

The 9-pin trace header provides instruction trace capabilities if the feature is available
on the inserted DIM.

DS70005562A-page 18 © 2024 Microchip Technology Inc. and its subsidiaries



FIGURE 2-10: TRACE HEADER

Trace Header

212 2MBIT SQl FLASH MEMORY

The SST26VF020A is a Quad SPI Flash® memory device (QSPI or SQI) with standard
SPI communication availability. When in use, the device operates in SPI mode until the
command to enable QSPI mode is sent, allowing the QSPI mode to be available at all
times.

FIGURE 2-11: QSPI FLASH

TIFE
|u
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Appendix A. Board Layout and Schematics

This appendix contains the jumpers, pinout, schematics and board layouts for the
dsPIC33A Curiosity Platform Development Board.

A.1  JUMPERS
Table A-1 shows the jumpers for the dsPIC33A Curiosity Platform Development Board Device.

TABLE A-1: JUMPERS

Jumper Description
J1 dsPIC33A Curiosity GP DIM Connector.
J2 2-pin 100 mil header used for dsPIC33A Current Measurement.
J3, J10 Two 2x25 pin 100 mil female header interfaces that can be used to connect to most DIM

pins for general purpose use.

J4, J5, J6, J7, J8, J9 | Six 100 mil headers used to determine which analog pins from the dsPIC33A connect to each
capacitive touch pad. All six channels can be connected at once, enabling redundant analog
measurement for each pad.

J11 Unpopulated 6-pin staggered header interface that can be used optionally to connect an
external programmer/debugger to the target DSC. The J11 header connects to the debug
port. The holes are slightly staggered to provide some friction retention force without requir-
ing physical soldering when a straight male-male or right angle male-male header is

installed.
J12 9-pin 100 mil header used for Trace communication.
J13,J14 Headers used for mikroBus interface connectors A and B, respectively.
J15,J16, J19,J20 |50 mil female headers used for interface with the LAN8670 RMII Evaluation Board.
J17,J18 Xplained Pro Extension Interface headers used to connect to a variety of boards.
J21 4-pin terminal connector used as the output of the CAN Driver circuit.
J22,J23 2-pin 100 mil headers that can be used as termination shunts for CANH and CANL.
J24 Micro-C USB connector. Used as a 5V power source for the board, PKOB4 programming
and COM ports.
J25 3-pin header used to select input voltage between USB power (5V_USB) and external
power (5V_EXT).
J26 2-pin terminal header for external 5V use.
J28 2-pin 100 mil header that can be shunted to hold PKOB4 in Reset, effectively deactivating

the PKOBA4 circuit.

© 2024 Microchip Technology Inc. and its subsidiaries DS70005562A-page 21
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A.2 PINOUT

Table A-2 shows the pinout for the dsPIC33A Curiosity Platform Development Board device.

TABLE A-2:  PINOUT

Name dsPIC33A Curiosity DIM Pin Name
P1_XPRO1_9 1 2 P2_XPRO1_10
P3_XPRO1_8 3 4 P4_mkB_B_XPRO1_SDA
P5 XPRO1_7 5 6 P6_mkB_B_XPRO1_SCL
P7_XPRO1_6 7 8 P8 XPRO1_13
P9 _XPRO1_5 9 10 P10_XPRO1_14
P11_XPRO1_4 11 12 P12_XPRO1_15
P13_XPRO1_3 13 14 P14_XPRO1_16
P15_XPRO1_1 15 16 P16_XPRO1_17

NC 17 18 P18_XPRO1_18
NC 19 20 P20_XPRO2_3
P21_mkB_B_TX 21 22 P22_XPRO2_4
P23_mkB_B_RX 23 24 P24_XPRO2_5
P25 _mkB_B_INT 25 26 P26_XPRO2_6
P27_mkB_B_PWM 27 28 P28_LED_O
P29 _mkB_B_AN 29 30 P30_LED_1
P31_mkB_B_RST 31 32 P32_LED_2
P33_mkB_B_CS 33 34 P34 _LED_3
P35 _mkB_B_SCK 35 36 P36_LED 4
P37_mkB_B_MISO 37 38 P38_Cap_Touch_3R
P39_mkB_B_MOSI 39 40 P40_Cap_Touch_3

P41_S3 41 42 P42_Cap_Touch_2R

P43_S2 43 44 P44 _Cap_Touch_2

P45_S1 45 46 P46_Cap_Touch_1R

P47_MCLR 47 48 P48 Cap_Touch_1
P49 _PGD 49 50 P50_LED_5
P51_PGC 51 52 P52_LED_6
NC 53 54 P54 _LED_7
P55_Board_VDD_Select 55 56 P56_Cap_Touch_DS
DIM_VDD 57 58 DIM_VDD
DIM_VDD 59 60 DIM_VDD
GND 61 62 GND
GND 63 64 GND
P65_mkB_A USB_SDA 65 66 P66_POT
P67_mkB_A USB_SCL 67 68 P68_LED_R
P69_mkB_A_TX 69 70 P70_LED_G
P71_mkB_A_RX 71 72 P72_LED_B
P73_mkB_A_INT 73 74 P74_QSPI_MOSI
P75_mkB_A_PWM 75 76 P76_QSPI_SCK
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TABLE A-2:  PINOUT (CONTINUED)

P77_mkB_A_AN 77 78 P78_QSPI_HOLD
P79 mkB_A RST 79 80 P80_QSPI WP
P81 _mkB_A CS 81 82 P82_QSPI_MISO
P83_mkB_A_SCK 83 84 P84_QPSI CS
P85_mkB_A_MISO 85 86 P86_CAN_STBY
P87 _mkB_A MOSI 87 88 P88_CAN_TXD
P89_RMII_NRST 89 90 P90_CAN_RXD
P91_RMII_IRQ 91 92 P92_GPIO
P93_RMII_MDIO 93 94 P94 _GPIO
P95_RMII_MDC 95 96 P96_UART_USB_RX
P97 _RMII_CRS_DV 97 98 P98_UART_USB_TX
P99 RMII_RXER 99 100 P100_UART PKoB_RX
P101_RMII_RXDO 101 102 P102_UART_PKoB_TX
P103_RMIl_RXD1 103 104 P104_TRCLK
P105_RMII_TXEN 105 106 P106_TRDATO
P107_RMII_TXDO 107 108 P108_TRDAT1
P109_RMI|_TXD1 109 110 P110_TRDAT2
P111_RMIl_CLK_IN 111 112 P112_TRDAT3
DIM_VDD 113 114 DIM_VDD
DIM_VDD 115 116 DIM_VDD
GND 117 118 GND
GND 119 120 GND
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A.5

dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD PCB LAYOUT

The dsPIC33A Curiosity Platform Development Board is a four-layer FR4, 1.6 mm, Plated-Through-Hole
(PTH) PCB construction. Figure A-8 and Figure A-9 illustrate the PCB layers.
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Board Layout and Schematics

FIGURE A-9: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOTTOM
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dsPIC33A CURIOSITY PLATFORM
DEVELOPMENT BOARD USER’S

MICROCHIP GUIDE

Appendix B. Bill of Materials (BOM)

This appendix contains the Bill of Materials (BOMs) for the dsPIC33A Curiosity
Platform Development Board.

B.1 BILL OF MATERIALS - dsPIC33A CURIOSITY PLATFORM DEVELOPMENT
BOARD

Table B-1 shows the Bill of Materials for the dsPIC33A Curiosity Platform Development
Board.

TABLE B-1:  dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM

Qty Designator Description Manufacturer Manufacturer Part #
9 _J2, J4, _J5, _J6, MECH HW JUMPER 2.54mm | Sullins Connector Solu- | SSC02SYAN
_J7, _J8, _J9, J25, 1x2 tions
_J28
10 |CH1,C4,C5,C7,C9, CAP CER0.1uF 50V 10% X7R | Yageo Corporation CC0603KRX7R9BB104
C10, C11,C12,C13, |SMD 0603
Cc17
4 C2,(C3,C6,C8 CAP CER 22uF 25V 20% X5R | Samsung CL21A226MAYNNNE
SMD 0805
4 C14,C15,C16, C18 CAP CER 1uF 16V 10% X7R | Taiyo Yuden EMK107B7105KA
SMD 0603
2 C19, C20 CAP CER 0.1uF 50V 10% X7R | Samsung CL21B104KBCNNNC
SMD 0805
1 C21 CAP TANT 22uF 25V 10% KEMET T491D226K025AT
0.80hm SMD D
1 C22 CAP CER 4700pF 100V 10% | TDK Corporation CGA3E2X7R2A472K080AA
X7R SMD 0603 AEC-Q200
33 |C23,C24,C25,C26, |CAPCERDO.1uF 25V 10% X7R | TDK Corporation C1005X7R1E104K050BB

C27,C28, C29, C30, |SMD 0402
C32, C35, C37, C48,
C49, C50, C53, C54,
C56, C57, C58, C59,
C60, C61, C62, C63,
C64, C65, C66, C67,
Ce68, C69, C70, C71,

C72

1 C33 CAP CER 10uF 25V 10% X5R |Murata Electronics © GRM21BR61E106KA73L
SMD 0805

2 C34, C41 CAP CER 47uF 10V 20% X5R | Murata Electronics GRM21BR61A476ME15K
0805

1 C36 CAP CER 0.022uF 16V 10% | Yageo Corporation CCO0402KRX7R7BB223
X7R SMD 0402

4 C38, C40, C51, C52 CAP CER 4.7uF 16V 10% X5R | TDK Corporation C1608X5R1C475K080AC
SMD 0603
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TABLE B-1:

dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM (CONTINUED)

1 C39

CAP CER 1000pF 50V 10%
X7R SMD 0402

Murata Electronics

GCM155R71H102KA37D

4 C42, C43, C44, C45 CAP CER 22uF 10V 20% X5R | Taiyo Yuden LMK212BBJ226MG-T
SMD 0805 >50%C_at_3V3

2 C46, C47 CAP CER 1uF 10V 10% X5R | Samsung CLO5A105KP5NNNC
SMD 0402

1 C55 CAP CER 10000pF 16V 10% |KEMET C0402C103K4RACTU
X7R SMD 0402

2 D3, D4 DIO TVS BIDIR PGB101 SMD | Littelfuse ® PGB1010402KR
0402

1 FB1 FERRITE 2A 220R SMD 0805 |Murata Electronics ® BLM21PG221SN1D

2 FB2, FB3 FERRITE 2A 600R SMD 0805 | TDK Corporation MPZ2012S601AT000

1 J1 CON EDGE HTEC8 0.80mm | Samtec HTEC8-160-01-L-DV-A-K-TR

120P Female SMD VERT

10 [J2, J4, J5, J6, J7, J8,
J9, J22, J23, J28

CON HDR-2.54 Male 1x2 Gold
5.84MH TH VERT

Multicomp SPC

SPC20481

2 J3, J10 CON HDR-2.54 Female 2x25 | Samtec SSW-125-01-F-D
Tin TH VERT

1 J12 CONN HEADER VERT Samtec TSW-105-07-L-D-010
10P0OS 2.54MM

2 J13, J14 SOCKET mikroBUS HOST Sullins Connector Solu- | PPTC081LFBN-RC
DIP 16 TH tions

2 J15, J16 CON STRIP-1.27 Female 1x3 | Samtec SLM-103-01-L-S
Gold TH VERT

2 J17, J18 CON HDR-2.54 Male 2x10 Sullins Connector Solu- |PBC10DBAN
Rotated 180Degrees Gold TH |tions
RT ANGLE

2 J19, J20 CON STRIP-1.27 Female 1x12 | Samtec SLM-112-01-L-S
Gold TH VERT

1 J21 CON TERMINAL 2.54mm 1x4 | On-Shore Technology OSTVNO04A150
Female 20-30AWG 6A TH R/A

1 J24 CON USB3.0 TYPE-C Advanced-Connectek NBR25-AK5322
FEMALE SMD R/A Inc.

1 J25 CON HDR-2.54 Male 1x3 Gold | Amphenol 68000103HLF
5.84MH TH VERT Communications

Solutions

1 J26 CON TERMINAL 2.54mm 1x2 |Phoenix Contact 1725656
Female 20-30AWG 6A TH R/A

1 L2 INDUCTOR 1uH 0.8A 20% Murata Electronics LQM21PN1ROMCOD
SMD 0805

11 |LEDO, LED1, LED2, DIO LED GREEN 2V 30mA Vishay ® |ite-On LTST-C190KGKT

LED3, LED4, LEDS,
LEDSG, LED7, LED9,
LED11, LED12

35mcd Clear SMD 0603

1 LED8

DIO LED TRI RED, GREEN,
BLUE 2.1V, 3.0V, 3.2V 50mA,
35mA, 35mA SMD 6-PLCC

Cree LED ®

CLX6F-FKC-CNP1ST1E
1BB7D3D3

2 LED10, LED13

DIO LED YELLOW 2.1V 20mA
6mcd Clear SMD 0603

Vishay Lite-On

LTST-C190YKT
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Bill of Materials (BOM)

TABLE B-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM (CONTINUED)
1 Q1 TRANS FET P-CH Diodes Incorporated ® DMP3099LQ
DMP3099LQ-7 -30V -3.8A
1.08W SOT-23-3
1 Q2 TRANS FET N-CH Nexperia 2N7002NXBKR
2N7002NXBKR 60V 270mA
2.8R 0.4W SOT23-3
3 R1, R3, R5 RES TKF 10k 1% 1/10W SMD | NIC Components Corp ® | NRCO6F1002TRF
0603
15 |R2, R4, R6, R7, RS, RES TKF 1k 1% 1/10W SMD | Stackpole Electronics, RMCF0603FT1KO00

R9, R20, R26, R27,
R28, R29, R30, R31,
R32, R33

0603

Inc.

R10

RES TKF 100R 1% 1/10W
SMD 0603 AEC-Q200 (Use
RSMT0696)

Yageo Coporation

ACO0603FR-07100RL

SMD 0402

5 R12, R38, R39, R40, |RES TKF OR 1/10W SMD Stackpole Electronics, RMCF0603ZTORO00
R41 0603 Inc.
2 R13, R16 RES TKF 20R 1% 1/10W SMD | Panasonic ® ERJ-3EKF20R0V
0603
1 R14 RES VARIABLE 10k 20% TH | TT Electronics / Bl Tech- | P090S-14T20BR10K
P090S nologies
5 R15, R17, R18, R50, |RES TKF 330R 1% 1/10W Stackpole Electronics, RMCFO0603FT330R
R52 SMD 0603 Inc.
1 R19 RES TKF 180R 1% 1/10W Yageo Corporation RC0603FR-07180RL
SMD 0603
4 R34, R35, R36, R37 RES TKF 2k 1% 1/10W SMD | Stackpole Electronics, RMCF0603FT2K00
0603 Inc.
2 R42, R43 RES TKF 60.4R 1% 1/4W Yageo Corporation RC1206FR-0760R4L
SMD 1206
4 R44, R45, R75, R84 RES TKF 100k 1% 1/10W KOA Speer Electronics, |RK73H1ETTP1003F
SMD 0402 AEC-Q200 Inc.
8 R46, R58, R61, R63, |RES TKF 10k 1% 1/10W SMD | Panasonic ERJ-2RKF1002X
R71, R73, R76, R103 |0402
2 R49, R51 RES TKF 15R 1% 1/16W SMD | Stackpole Electronics, RMCFO0603FT15R0
0603 Inc.
3 R53, R54, R69 RES TKF 470R 1% 1/16W MF | Yageo Corporation RC0402FR-07470RL
0402
3 R55, R56, R57 RES TKF 56k 1% 1/16W SMD | Rohm Semiconductor MCRO1MZPF5602
0402
2 R62, R67 RES TKF 5.11k 1% 1/10W KOA Speer Electronics, |RK73H1ETTP5111F
SMD 0402 AEC-Q200 Inc.
1 R64 RES TKF 442k 1% 1/16W Samsung RC1005F4423CS
SMD 0402
1 R65 RES TKF 95.3k 1% 1/16W Yageo Corporation AC0402FR-0795K3L
SMD 0402 AEC-Q200
1 R66 RES TKF 24.3k 1% 1/16W Samsung RC1005F2432CS
SMD 0402
2 R68, R83 RES TKF 5.62k 1% 1/16W Vishay / Dale CRCWO04025K62FKED
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TABLE B-1: dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM (CONTINUED)
2 R70, R85 RES TKF 31.6k 1% 1/10W Panasonic ERJ-2RKF3162X
SMD 0402
4 R72, R86, R100, R101 | RES TKF 47k 5% 1/10W SMD | Panasonic ERJ-2GEJ473X
0402
1 R74 RES TF 2.2k 1% 1/10W SMD | Stackpole Electronics, RMCF0603FT2K20
0603 AEC-Q200 Inc.
1 R77 RES TKF 1M 1% 1/10W SMD | Panasonic ERJ-2RKF1004X
0402
1 R78 RES TF 910k 0.1% 1/16W TE Connectivity CPF0603B910KE1
SMD 0603
1 R79 RES TKF 487K 1% 1/10W Panasonic ERJ-2RKF4873X
SMD 0402
1 R80 RES TKF 340k 1% 1/10W Panasonic ERJ-2RKF3403X

SMD 0402

4 R81, R82, R92, R96 RES TKF 4.7k 1% 1/16W SMD | Yageo Corporation RC0402FR-074K7L
0402
9 R87, R88, R89, R90, |RES TKF 330R 1% 1/16W Yageo Corporation RC0402FR-07330RL
R91, R94, R95, R97, |SMD 0402
R102
2 R93, R98 RES TKF 3.3k 1% 1/10W SMD | Panasonic ERJ-2RKF3301X
0402
4 S$1, 82, S3, S4 SWITCH TACT SPST 12V C&K Switches ® PTS645SM43SMTRO2LFS
50mA PTS645SM43SMTR92
LFS SMD
5 TP1, TP2, TP3, TP4, CON TP LOOP Black TH Keystone Electronics ® 5011
TP5
1 U9 IC SWITCH SPDT Rochester Electronics ® | SN74LVC1G3157DCKR
74LVC1G3157 SC-70-6
4 U11, U12, U13, U14 IC TRANSCEIVER Nexperia 74LVC1T45GM,115
74LVC1T45GM or
74LVC1T45GW Single Bit Volt-
age Translator SOT-886
SOT-363 Dual FP
Microchip Parts listed below
1 U1 MCHP MEMORY SERIAL Microchip Technology SST26VF020A-80E/SN
FLASH 16M 104MHz
SST26VF020A-80E/SN
SOIC-8
1 u2 MCHP INTERFACE CAN Microchip Technology ATAB6563-GAQW1
ATA6563-GAQW1 SOIC-8
1 u3 MCHP INTERFACE USB Microchip Technology MCP2221A-I/ML
12C/UART MCP2221A-I/ML
QFN-16
1 u4 MCHP INTERFACE USB 2.0 | Microchip Technology USB2422-1/MJ
HS 2 PORT HUB CTRLR
QFN-24 USB2422-1/MJ
1 us MCHP ANALOG POWER Microchip Technology MIC2042-1YTS
SWITCH 5.5V 3A
MIC2042-1YTS TSSOP-14
1 U6 MCHP ANALOG LDO 3.3V Microchip Technology MCP1727-3302E/MF

MCP1727-3302E/MF
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Bill of Materials (BOM)

TABLE B-1:

dsPIC33A CURIOSITY PLATFORM DEVELOPMENT BOARD BOM (CONTINUED)

1

u7

MCHP ANALOG SWITCHER
Boost 3V to 5.5V
MIC2877-AYFT-TR FTQFN-8

Microchip Technology

MIC2877-AYFT-TR

us

MCHP MCU 32-BIT 300MHz
2MB 384kB
ATSAME70N21B-ANT
LQFP-100

Microchip Technology

ATSAME70N21B-ANT

u10

MCHP MEMORY SERIAL
EEPROM 256k 12C
241.C256T-E/ST TSSOP-8

Microchip Technology

24LC256T-E/ST

Y1

MCHP OSC MEMS DSC6011-
JI2B-024.0000_2.5LX2.0WXO0.
89H_LGA

Microchip Technology

DSC6011J12B-024.0000

Y2

MCHP CLOCK OSCILLATOR
SINGLE 12.000MHZ
DSC6011J11B-012.0000 VLGA

Microchip Technology

DSC6011J11B-012.0000

Mechanical Parts to be added in the package

0603

1 LABEL1 LABEL PCBA 18x6mm Data- |ACT Logimark AS ® 505462
matrix Assy# / Rev / Serial /
Date

8 PAD1, PAD2, PAD3, MECH HW RUBBER PAD 3M™ SJ5076BLACK

PAD4, PADS5, PADG, Cylindrical flat top D8H2.8
PAD7, PAD8 Black

PCB

1 PCB1 Printed Circuit Board 04-11931-R3

Do Not Populate Parts listed below

2 D1, D2 DIO TVS PESD1IVN27-AX Nexperia PESD1IVN27-AX
45V 3A SOD-323

1 J11 CON HDR-2.54 Male 1x6 Sullins Connector Solu- | PBC36SAAN
Staggered DNP tions

1 Ja27 CON HDR-1.27 Male 1x2 Gold | Harwin M50-3530242
TH VERT

1 L1 CM CHOKE 5.1k@10MHz TDK Corporation ACT1210D-101-2P-TL0OO
1.5R SMD 1210 AEC-Q200

1 R11 RES TKF OR 1/10W SMD Stackpole Electronics, RMCF0603ZTORO00
0603 Inc.

2 R59, R60 RES TKF 15R 1% 1/16W SMD | Stackpole Electronics, RMCFO0603FT15R0

Inc.
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Note the following details of the code protection feature on Microchip products:

. Microchip products meet the specifications contained in their particular Microchip Data Sheet.

. Microchip believes that its family of products is secure when used in the intended manner, within operating specifications, and

under normal conditions.

. Microchip values and aggressively protects its intellectual property rights. Attempts to breach the code protection features of
Microchip product is strictly prohibited and may violate the Digital Millennium Copyright Act.

. Neither Microchip nor any other semiconductor manufacturer can guarantee the security of its code. Code protection does not
mean that we are guaranteeing the product is "unbreakable" Code protection is constantly evolving. Microchip is committed to
continuously improving the code protection features of our products.

This publication and the information herein may be used only
with Microchip products, including to design, test, and integrate
Microchip products with your application. Use of this informa-
tion in any other manner violates these terms. Information
regarding device applications is provided only for your conve-
nience and may be superseded by updates. It is your responsi-
bility to ensure that your application meets with your
specifications. Contact your local Microchip sales office for
additional support or, obtain additional support at https:/
www.microchip.com/en-us/support/design-help/client-support-
services.

THIS INFORMATION IS PROVIDED BY MICROCHIP "AS IS".
MICROCHIP MAKES NO REPRESENTATIONS OR WAR-
RANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED,
WRITTEN OR ORAL, STATUTORY OR OTHERWISE,
RELATED TO THE INFORMATION INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES OF NON-
INFRINGEMENT, MERCHANTABILITY, AND FITNESS FORA
PARTICULAR PURPOSE, OR WARRANTIES RELATED TO
ITS CONDITION, QUALITY, OR PERFORMANCE.

IN NO EVENT WILL MICROCHIP BE LIABLE FOR ANY INDI-
RECT, SPECIAL, PUNITIVE, INCIDENTAL, OR CONSE-
QUENTIAL LOSS, DAMAGE, COST, OR EXPENSE OF ANY
KIND WHATSOEVER RELATED TO THE INFORMATION OR
ITS USE, HOWEVER CAUSED, EVEN IF MICROCHIP HAS
BEEN ADVISED OF THE POSSIBILITY OR THE DAMAGES
ARE FORESEEABLE. TO THE FULLEST EXTENT
ALLOWED BY LAW, MICROCHIP'S TOTAL LIABILITY ON
ALL CLAIMS IN ANY WAY RELATED TO THE INFORMATION
ORITS USE WILL NOT EXCEED THE AMOUNT OF FEES, IF
ANY, THAT YOU HAVE PAID DIRECTLY TO MICROCHIP
FOR THE INFORMATION.

Use of Microchip devices in life support and/or safety applica-
tions is entirely at the buyer's risk, and the buyer agrees to
defend, indemnify and hold harmless Microchip from any and
all damages, claims, suits, or expenses resulting from such
use. No licenses are conveyed, implicitly or otherwise, under
any Microchip intellectual property rights unless otherwise
stated.

For information regarding Microchip’s Quality Management Systems,
please visit www.microchip.com/quality.
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